Document and Software Copyrights
Copyright © 1998-2014 by ShoreTel Inc., Sunnyvale, California, USA. All rights reserved.
Printed in the United States of America. Contents of this publication may not be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without prior written authorization of ShoreTel, Inc. ShoreTel, Inc. reserves the right to make changes without notice to the specifications and materials contained herein and shall not be responsible for any damage (including consequential) caused by reliance on the materials presented, including, but not limited to typographical, arithmetic or listing errors.

Trademarks
ShoreTel, ShoreTel (and logo), Brilliantly Simple, Brilliantly Simple Communication, ShorePhone, and ShoreWare are registered trademarks of ShoreTel, Inc. in the United States and/or other countries. The ShoreTel logo is a trademark of ShoreTel, Inc. in the United States and/or other countries.
All other copyrights and trademarks herein are the property of their respective owners.

Patents
ShoreTel products are covered by patents as listed at http://www.shoretel.com/about/patents.html.

Version Information
ShoreTel Server 14.2
Conferencing User Guide
Part Number: 800-1694-01
Version: CUG_14.2_08012014
Date: August 2014

Company Information
ShoreTel, Inc.
960 Stewart Drive
Sunnyvale, California 94085 USA
+1.408.331.3300
+1.408.331.3333 (fax)
www.shoretel.com
## Contents

**About this Guide** ................................................................. 6
- Objectives ........................................................................ 6
- Organization ..................................................................... 6
- Document Conventions .................................................... 6

**Chapter 1** ShoreTel Conference Web Overview ..................... 7
- Introduction ....................................................................... 8
- Hosting a Conference ..................................................... 8
- Participating in a Conference ........................................... 8
- Conference Interface ....................................................... 8
- ShoreTel Web Conference Features .................................. 9

**Chapter 2** ShoreTel Conference Web Portal .......................... 10
- Overview ............................................................................. 12
- Accessing ShoreTel Conference Web Portal ..................... 12
  - Accessing Portal from a Web Browser .......................... 12
  - Accessing from ShoreTel Communicator ..................... 13
- My Conferences ............................................................... 14
  - Conferences .................................................................. 14
  - Recordings ..................................................................... 15
  - Conference Options ..................................................... 17
  - Comments ..................................................................... 18
- Personal Library ............................................................... 18
  - Adding Media to Personal or Shared Library .................. 19
  - Deleting Media from Personal or Shared Library .......... 20
  - Editing Attributes of Files in Personal or Shared library 20
- My Profile .......................................................................... 21
  - Accessing and Uploading Pictures ............................... 21
  - Removing or Replacing Pictures ................................. 21
- Using Conference Web Portal ........................................... 22
  - Conferences Page ......................................................... 22
  - Recordings Page .......................................................... 25
  - System Test Page ........................................................ 25
  - Speed Test Page .......................................................... 25
**Chapter 3  Conferencing** ................................................................. 27
  Overview .................................................................................. 28
  Creating Conferences .................................................................. 28
  Set Default Time Zone ................................................................. 30
  Invite Conference Participants Through ShoreTel Conference Web Portal .................................................. 31
  Edit Conferences ........................................................................ 32
  View Conference Page Option .................................................... 32
  Delete a Conference ................................................................. 33

**Chapter 4  Joining and Hosting a Conference** ................................. 35
  Overview .................................................................................. 36
  Enforced Conference Schedules ................................................... 36
  Joining Conferences ..................................................................... 36
  Joining Conferences from Email Invitation .................................. 36
  Joining Conferences from ShoreTel Conference Web Portal ........ 37
  Conference Host ........................................................................ 40
  Joining Conferences as Host ...................................................... 40
  Desktop Sharing .......................................................................... 41
  Ending a Conference .................................................................... 48

**Chapter 5  Conference Presenter** .................................................. 49
  Overview .................................................................................. 50
  ShoreTel Presenter for Windows .................................................. 50
  Installation .................................................................................. 50
  ShoreTel Presenter for Java ........................................................ 51
  Requirements .............................................................................. 51
  Installing ShoreTel Presenter on an Apple Macintosh ...................... 52
  ShoreTel Presenter ........................................................................ 52
  Launching Presenter .................................................................... 52
  Presenter menu ........................................................................... 53
  Sharing Windows Options .......................................................... 54
  Setting the Sharing Resolution ..................................................... 55
  Adjusting Quality of Shared Image ............................................... 56
  Adjusting the Outgoing Bandwidth ............................................... 57

**Chapter 6  Conference Viewer** ..................................................... 58
  Overview .................................................................................. 59
  Host Web Conference Page ........................................................ 59
  Share Menu ................................................................................ 60
  More menu ................................................................................ 61
  Displaying the More Menu ........................................................ 62
  Participant Panel ......................................................................... 64
  Audio Conference Options ........................................................ 65
  Participant Web Conference Page ............................................... 66
  Sharing ...................................................................................... 67
# Table of Contents

## Chapter 7  Instant Conferencing  ................................................................. 70
- Overview .................................................................................. 71
- Requirements ............................................................................ 71
- Configuring Data Collaboration Session ................................. 71

## Chapter 8  Conferencing for iOS  ............................................................... 73
- Overview .................................................................................. 74
- Setting Up the ShoreTel Conferencing App ............................. 74
  - Installing the Conferencing App ............................................. 74
  - Configuring the Conferencing App ....................................... 74
- Hosting and Joining a Conference .............................................. 74
  - Hosting a Conference ............................................................ 75
  - Joining a Conference ............................................................ 75
- Working with the Conference Screen ........................................ 75
- Viewing Conference Information ............................................. 76
  - Viewing the List of Participants ............................................. 76
- Presenting .................................................................................. 77
- Viewing Presentations .............................................................. 77
- Viewing Files ............................................................................ 78
- Messaging ................................................................................ 78
  - Sending a Message ............................................................... 78
  - Receiving a Message ............................................................ 78
- Conference Actions ................................................................. 79
- CDMA Devices .......................................................................... 80

## Chapter 9  Microsoft Outlook Integration  .................................................. 81
- Overview .................................................................................. 82
- Microsoft Outlook Calendar .................................................. 82
  - Integrating with Microsoft Outlook Calendar ....................... 82
  - Creating a Conference in Outlook ......................................... 82
  - Changing conference settings in Outlook ............................. 84
- Conferencing Parameters ....................................................... 84
- Uninstalling ShoreTel Calendar Integration Tool in Outlook 86

## Appendix A  Telephone Commands for Audio Control  .............................. 87
About this Guide

Objectives

This document provides information about using ShoreTel Conferencing and is designed for ShoreTel Conference users.

Organization

This document presents the major tasks you must complete to set up and use the ShoreTel Conference features.

Document Conventions

- The document uses the following typographical conventions:
  - Data-entry field names, hypertext links, control buttons, keywords, and other items within the system interface appear in **boldface** text.
  - Information that you enter in data-entry fields appears in a **data_entry** font.
Chapter 1

ShoreTel Conference Web Overview

This Chapter provides information about the ShoreTel conference web and its features. It contains the following information:

Introduction .................................................................................................................. 8
Hosting a Conference .................................................................................................. 8
Participating in a Conference .................................................................................... 8
Conference Interface ................................................................................................. 8
  Conference Viewer: Used primarily by hosts to schedule, start, delete conferences and access their recordings. ................................................................. 8
  Conference Web Portal: Used primarily by hosts to schedule, start, delete conferences and access their recordings ......................................................... 9
  Conference Administration Site: Allows an Administrator to configure web site parameters, establish default conference parameters, and also view and generate web conference reports ................................................................. 9
ShoreTel Web Conference Features ......................................................................... 9
Introduction

ShoreTel Conference Web provides an easy-to-use tool to conference calls, share your desktop or applications with others, make presentations, and record conferences.

Conferences can be web and audio, web only, or audio only conferences.

ShoreTel Conference Web runs in a standard Web browser and does not require installation of any special software if your computer is running ShoreTel Communicator.

Hosting a Conference

As a ShoreTel Conference Host, you can:

- Create new conferences and edit and delete existing conferences.
- Lead a conference and give presentation rights.
- Browse a list of conferences and conference owners.
- Manage library content for conferences.
- View details about your conferences.
- Play or download recordings.

Participating in a Conference

As a ShoreTel Conference participant, you can:

- Access a conference by following instructions on a conference invite.
- Access and view listing of available public conferences.
- View and play available recordings.

Conference Interface

ShoreTel Conference Web is accessible through the following three user interfaces:

- Conference Viewer: Used primarily by hosts to schedule, start, delete conferences and access their recordings.
ShoreTel Conference Web Overview

- Conference Web Portal: Used primarily by hosts to schedule, start, delete conferences and access their recordings.
- Conference Administration Site: Allows an Administrator to configure web site parameters, establish default conference parameters, and also view and generate web conference reports.

**Note**
You can also access the ShoreTel Conference Web Portal from Microsoft Outlook and ShoreTel Communicator for Windows.

ShoreTel Web Conference Features

The following table lists the ShoreTel web conference features:

<table>
<thead>
<tr>
<th>Conference Management</th>
<th>Conference Audio</th>
<th>Conference Web</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled, instant, and reservationless conference</td>
<td>HD audio</td>
<td>Zero install for participants</td>
</tr>
<tr>
<td>Customizable host and participant access codes</td>
<td>Telephone user interface (TUI) with wide number of commands</td>
<td>Zero install for hosts using ShoreTel Communicator</td>
</tr>
<tr>
<td>Audio and Web conference Recordings/Playback</td>
<td>Call participant</td>
<td>Application and desktop sharing</td>
</tr>
<tr>
<td>Secure Conference Web:</td>
<td>Integrated conference button on ShoreTel IP phone</td>
<td>Application and desktop sharing recording/playback</td>
</tr>
<tr>
<td>Encrypted Web conferences (HTTPS)</td>
<td></td>
<td>Shared and Private library</td>
</tr>
<tr>
<td>Encrypted audio conferences (SRTP)</td>
<td></td>
<td>Whiteboard</td>
</tr>
<tr>
<td>7-Digit access</td>
<td></td>
<td>File transfer</td>
</tr>
<tr>
<td>Conference locking</td>
<td></td>
<td>Conference Chat</td>
</tr>
<tr>
<td>Requiring a password to join a Web conference</td>
<td></td>
<td>Support for Microsoft PowerPoint and any Flash document</td>
</tr>
<tr>
<td>Outlook scheduling</td>
<td></td>
<td>Resilient Conference Web</td>
</tr>
</tbody>
</table>
This chapter provides instructions for using the ShoreTel Conference Web Portal. It contains the following information:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>12</td>
</tr>
<tr>
<td>Accessing ShoreTel Conference Web Portal</td>
<td>12</td>
</tr>
<tr>
<td>Accessing from a Web Browser</td>
<td>12</td>
</tr>
<tr>
<td>Accessing from ShoreTel Communicator</td>
<td>13</td>
</tr>
<tr>
<td>My Conferences</td>
<td>14</td>
</tr>
<tr>
<td>Conferences</td>
<td>14</td>
</tr>
<tr>
<td>Recordings</td>
<td>15</td>
</tr>
<tr>
<td>Conference Options</td>
<td>17</td>
</tr>
<tr>
<td>Comments</td>
<td>18</td>
</tr>
<tr>
<td>Personal Library</td>
<td>18</td>
</tr>
<tr>
<td>Adding Media to Personal or Shared Library</td>
<td>19</td>
</tr>
<tr>
<td>Deleting Media from Personal or Shared Library</td>
<td>20</td>
</tr>
<tr>
<td>Editing Attributes of Files in Personal or Shared library</td>
<td>20</td>
</tr>
<tr>
<td>My Profile</td>
<td>21</td>
</tr>
<tr>
<td>Accessing and Uploading Pictures</td>
<td>21</td>
</tr>
<tr>
<td>Removing or Replacing Pictures</td>
<td>21</td>
</tr>
</tbody>
</table>
Using Conference Web Portal................................................................. 22
Conferences Page.................................................................................. 22
Recordings Page..................................................................................... 25
System Test Page................................................................................... 25
Speed Test Page .................................................................................... 25
Overview

From the ShoreTel Conference Web Portal, you can create conferences, upload files for use in conferences, create a user profile, and more.

Note
If you are on a system with Audio Conference licenses only, you cannot upload files.

Depending on the settings of your ShoreTel system, you are presented with one of the following web portals when opening up the ShoreTel Conference Web Portal:

- The ShoreTel Conference Web Portal for web and audio.
  - Opened when the system supports both conference Web and conference audio.
- The ShoreTel Conference Web Portal for audio.
  - Opened when the system supports conference audio only.

Accessing ShoreTel Conference Web Portal

You can access the ShoreTel Conference Web Portal from a Web browser (Accessing Portal from a Web Browser on page 12) or from ShoreTel Communicator (Accessing from ShoreTel Communicator on page 13).

Microsoft Internet Explorer 9.0 or later, Firefox 5.0, or Safari 5.0 is required to access the ShoreTel Conference Web Portal from a browser.

If you are logged into ShoreTel Communicator, you can access the ShoreTel conference Web portal by clicking Window > Conference Web Portal.

Accessing Portal from a Web Browser

When accessed from a web browser, the ShoreTel Conference Web Portal opens at the Public page. From there, you log into the My Conferences page.

To log into My Conferences, you need the following:

- Your ShoreTel user ID.
- Your ShoreTel conference password.
Logging into the Web Portal

1. From the supported browser, in the Address field, type the URL for the ShoreTel Conference application.

   Note
   The ShoreTel conference Web Portal is opened to the Public page for systems supporting conference audio and conference Web or for systems supporting conference audio only.

2. Click Sign In in the upper right hand corner of the page.

   The Sign In page is displayed.

3. Enter your ShoreTel user ID.

4. Enter your ShoreTel password.

   Note
   The password must consist of standard ASCII characters. Non-ASCII characters are not supported.

5. Click the Sign In button.

   The My Conferences page is displayed.

   Note
   The first time you sign into the web portal, you must set the time zone for your conference device. Select your local time zone. The system automatically adjusts conference times to your local time.

Accessing from ShoreTel Communicator

1. Launch ShoreTel Communicator.

2. Click Windows > Conference Web Portal (Ctrl+Shift+K).

3. The ShoreTel conference Web site is opened in your default browser.

   Depending on how your system is configured, the audio and Web version of the My Conferences page is displayed, or the audio only version of the My Conferences page is displayed.

   Note
   The first time you sign into the web portal, you must set the time zone for your conference device. Select your local time zone. The system automatically adjusts conference times to your local time.
My Conferences

From here, you can create and manage your conferences.

If you receive a conference invite, follow the instructions in the message to join a conference, which direct you to the My Conferences page.

If you are logged into the web portal, join a conference through the My Conferences page.

My Conferences includes four pages:

Conferences

From here, you can create and view conferences.

Accessing Conferences

- Click Conferences.

The Conference page is displayed.

Note

You can also join a conference by entering the access code for the conference in the Access Code field.

The following table describes the fields on the Conferences page.

Table 2: Conferences

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a Conference</td>
<td>Create a new conference. Launches Add a Conference page; from here, you can create one-off conferences and recurring conferences.</td>
</tr>
<tr>
<td>Download Presenter Software</td>
<td>Download ShoreTel Presenter for Windows. It is optimized for Windows computers. A computer must have a presenter to share data. Java 1.6.0.15 Runtime Environment can also be used to perform presenter functions. Note: Not applicable in audio only Web page</td>
</tr>
<tr>
<td>Access Code</td>
<td>Lists numbers used by the system to identify conferences. The system automatically generates an access code for each new conference (which can be edited). This number is used by participants to join the conference.</td>
</tr>
<tr>
<td>Today's Conference</td>
<td>Lists conferences scheduled for today.</td>
</tr>
<tr>
<td>Conferences</td>
<td>Lists conferences scheduled for days after today.</td>
</tr>
<tr>
<td>Date</td>
<td>Date of scheduled conference, including date for recurring conferences.</td>
</tr>
</tbody>
</table>
Recordings

From here, you can view, play, download, edit, and delete conference recordings.

You can also invite conference participants to listen to and view recordings.

Viewing Recordings

- Click **Recordings**.

  The Recordings page is displayed.

  The recordings made by you are listed.

  **Note**

  Recordings made during a conference are automatically added to the recordings list.

The following table describes the fields on the Recordings page:

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invite</td>
<td>Access e-mail message automatically sent by the system to specified conference participants.</td>
</tr>
<tr>
<td>Edit</td>
<td>Modify conference parameters. Only conferences created in the ShoreTel Conference Web Portal can be modified. Conferences created in Microsoft Outlook or another calendar can be modified only in those applications</td>
</tr>
<tr>
<td>Join</td>
<td>Join a conference.</td>
</tr>
<tr>
<td>Set default time zone</td>
<td>Specify your local time zone. All conference information is adjusted to your local time, including conferences schedule in different time zones.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>Display name and location of recordings.</td>
</tr>
<tr>
<td>Go</td>
<td>Display contents of selected folder.</td>
</tr>
<tr>
<td>Rename folder to</td>
<td>Rename recording folder.</td>
</tr>
<tr>
<td>Rename</td>
<td>Rename recording file.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete file.</td>
</tr>
<tr>
<td>Move selection</td>
<td>Move selected folder from one location to another.</td>
</tr>
<tr>
<td>Move</td>
<td>Transfer recordings to selected folder.</td>
</tr>
</tbody>
</table>
Accessing Recordings

1. From Show, select a recording.

2. Click Go.

   The recording is displayed.

Playing Recordings

1. Click Play.

2. Click the buttons to control playback.

Editing Recordings

1. Select a recording.

2. Click Edit.

   The Update Recording page is displayed.

3. Specify Login options.

4. Click Show more options.

   The Publish and Comments options are displayed.

5. Specify publishing and comments options.

6. Click Submit.

   The options are saved.
Deleting Recordings
1. Select a recording.
2. Click Delete and follow the prompts.

Moving Recordings from One Location to Another
1. Select a recording.
2. Click Move selection to.
3. Select a folder in the drop down menu, or type the folder name in the Untitled field.
4. Click Move.

The recording is moved to the new folder.

Renaming Recordings
1. From Show, select a folder.
2. Type a new name in Rename folder to.
3. Click Rename.

The folder is renamed.

Conference Options
From here, you can affix a logo to your conference pages and set parameters that affect user participation. The following table lists the available conference options.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logo</td>
<td>Select a logo for display on conference title bar. Acceptable file formats: .jpeg, .gif, or .png files.</td>
</tr>
<tr>
<td>Reset to default</td>
<td></td>
</tr>
<tr>
<td>Participant</td>
<td>Participant options:</td>
</tr>
<tr>
<td></td>
<td>■ Participants can see everyone’s name.</td>
</tr>
<tr>
<td></td>
<td>■ Participants can send messages to everyone.</td>
</tr>
<tr>
<td></td>
<td>■ Participants can only send messages to the host.</td>
</tr>
<tr>
<td></td>
<td>■ Participants can only see the host’s name.</td>
</tr>
<tr>
<td>Alert Sound</td>
<td>Tone signaling that a participant has joined or left conference.</td>
</tr>
</tbody>
</table>
Comments

From here, you can make comments public or private, or you can delete them.

The following table lists the options for comments.

<table>
<thead>
<tr>
<th>Position</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Conference</td>
<td>All comments are displayed.</td>
</tr>
<tr>
<td>2</td>
<td>Make Public</td>
<td>Make selected comments available to all viewers.</td>
</tr>
<tr>
<td>3</td>
<td>Make Private</td>
<td>Make selected comments available to specific viewers.</td>
</tr>
<tr>
<td>4</td>
<td>Delete</td>
<td>Remove comment.</td>
</tr>
<tr>
<td>5</td>
<td>Entry Check Box</td>
<td>Enable comment entry.</td>
</tr>
<tr>
<td>6</td>
<td>Name of Commentator</td>
<td>Commentator name.</td>
</tr>
<tr>
<td>7</td>
<td>Date and Time</td>
<td>Date and time comment was sent.</td>
</tr>
<tr>
<td>8</td>
<td>Name of Conference</td>
<td>Conference name.</td>
</tr>
<tr>
<td>9</td>
<td>Disposition</td>
<td>Disposition of comment.</td>
</tr>
<tr>
<td>10</td>
<td>Comment</td>
<td>Entire posted comment.</td>
</tr>
<tr>
<td>11</td>
<td>Count</td>
<td>Number of comments listed on current page.</td>
</tr>
</tbody>
</table>

Personal Library

From here, you can manage files that can be shared in conferences.

You can add presentations, pictures, audio, and video to your personal (private) or shared (public) library.

You can also delete files from the libraries and edit the attributes of the files in the libraries.

Importable file formats include:

- .ppt (PowerPoint)
- .jpeg (photo)
The following table lists the personal library options:

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit Window</td>
<td>Expand library file section into browser.</td>
</tr>
<tr>
<td>Restore Window</td>
<td>Revert expanded library view to default library view.</td>
</tr>
<tr>
<td>Refresh library</td>
<td>Reload library.</td>
</tr>
<tr>
<td>Add</td>
<td>Add new file to library folder.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete a file from library folder.</td>
</tr>
<tr>
<td>Edit</td>
<td>Add information to file label.</td>
</tr>
<tr>
<td>Personal Library Folder</td>
<td>Personal (private) folder.</td>
</tr>
<tr>
<td>Shared Library Folder</td>
<td>Shared (public) folder.</td>
</tr>
<tr>
<td>View Panel</td>
<td>Viewing area.</td>
</tr>
<tr>
<td>Use Presenter Window client</td>
<td>Download presenter software for your computer.</td>
</tr>
<tr>
<td>Public</td>
<td>Open Public tab of ShoreTel Conference Web Portal.</td>
</tr>
</tbody>
</table>

Adding Media to Personal or Shared Library

1. Double-click Personal Library or Shared Library.

   The library is highlighted and opened.

2. Click/select a destination folder (pictures, presentations, video files, audio files).

3. Click Add.

   The Add to library: window is opened.

4. Select a Media group.

5. Browse to, select, and open the media.

6. In the Add to library: Media Library window, click File Attributes.

   The File Attributes window is opened.

7. Enter the attributes.

8. Click OK.

   The media is uploaded.
Deleting Media from Personal or Shared Library

1. Double-click **Personal Library** or **Shared Library**.
   The library is highlighted and opened.

2. Click/select a destination folder (pictures, presentations, video files, audio files).

3. Click/select a file.
   The **Delete** and **Edit** buttons are activated.

4. Click **Delete**.
   The **Deleting** dialog is opened.
   You are prompted to delete the file.

5. Click **Yes**.
   The media is deleted.

---

**Note**
Files cannot exceed 12 MB. Upload time cannot exceed 10 minutes.

**Note**
To import .PPT, ShoreTel Presenter for Windows and MS PowerPoint must be installed on your local PC.

---

Editing Attributes of Files in Personal or Shared library

1. Double-click **Personal Library** or **Shared Library**.
   Library is highlighted and opened.

2. Click/select a destination folder (pictures, presentations, video files, audio files).

3. Click/select a file.
   The **Delete** and **Edit** buttons are activated.

4. Click **Edit**.
   The **Edit Media** window is opened.

**Note**
Personal Library files can be deleted only by the owner of the media. Shared Library files can be deleted by anyone.
5. Enter edits.
6. Click **Save**.

   The edits are incorporated.

---

**My Profile**

From here, you can upload a picture for your conference host profile. The picture is displayed in the Public Conferences tab for conferences hosted by you. The picture is also displayed under Information in the Conference Viewer.

Importable file formats include:

- .jpg
- .gif
- .png

**Accessing and Uploading Pictures**

1. Click **Browse**.
2. Navigate to a picture file.
3. Click **Save**.

   The picture is displayed in your conference in the upper-right Info panel.

**Removing or Replacing Pictures**

1. Click **Browse**.
2. Navigate to a picture file.
3. Click **Save**.

   The picture is replaced.
Using Conference Web Portal

Public is the home page of the ShoreTel Conference Web Portal. Use Public to join a conference if you do not receive a conference invite or if you are not logged into the web portal.

Note

If you receive a conference invite, follow the instructions in the message to join a conference, which direct you to the My Conferences page (see My Conferences on page 14). If you are logged into the web portal, join a conference through the My Conferences page (see My Conferences on page 14).

From Public, you can perform the following tasks:

- List conferences available for public access.
- List conference recordings available for public access.
- Verify your computer is set up to use conference web.
- Verify your computer network connection is adequate for conference web.
- Download and install ShoreTel presentation tools required to use conference web.

The following table describes the fields on the Public page:

**Table 7: Public Page**

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sign In</td>
<td>Log into your ShoreTel Conference Web Portal.</td>
</tr>
<tr>
<td>Help</td>
<td>Launch online help.</td>
</tr>
<tr>
<td>Access Code</td>
<td>Conference access code. Enter code, then click Join.</td>
</tr>
<tr>
<td>Conferences</td>
<td>Display Public conferences page, which lists conferences available to all users.</td>
</tr>
<tr>
<td>Recordings</td>
<td>Display conference recordings available to public.</td>
</tr>
<tr>
<td></td>
<td>Conference recordings can be downloaded for later listening.</td>
</tr>
<tr>
<td>System Test</td>
<td>Test if computer is set up to support Web conferencing.</td>
</tr>
<tr>
<td>Speed Test</td>
<td>Test speed of network connection between your computer and appliance set up to support Web conferencing.</td>
</tr>
<tr>
<td>Download</td>
<td>Display Download page, which includes links to applications that can be installed to facilitate Web conference presentations.</td>
</tr>
</tbody>
</table>

Conferences Page

From here, you can view a list of conferences, join a conference, or post a comment (for conferences accepting comments).

The following table describes the fields on the Conferences page:
Listing Conferences

1. In the Show field, select a search parameter.
2. Click Go.

The results are displayed.

Note

You can also list conferences using the Search field: Enter the name or part of the name of a conference or host (or a conference access code), then click Search.

Joining a Conference

- Click a conference name, or click Join.

For more information about joining a conference, see Joining Conferences on page 36.

Viewing Information about a Conference

- Click Info.

A page containing information about a conference (including comments posted to the conference Web site) is displayed.
The following table lists conference information and fields:

### Table 9: Conference Information

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Conference name.</td>
</tr>
<tr>
<td>Hosted by</td>
<td>Conference host.</td>
</tr>
<tr>
<td>Join</td>
<td>Join conference.</td>
</tr>
<tr>
<td>Login</td>
<td>Log into conference.</td>
</tr>
<tr>
<td>Telephone</td>
<td>Number needed to dial into a conference.</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments made by conference participants (if enabled).</td>
</tr>
<tr>
<td>Post a comment</td>
<td>Leave a comment. This link is not displayed if Comment is disabled.</td>
</tr>
</tbody>
</table>

**Posting a Comment (if enabled)**

1. Enter a conference.
2. Click **Post a comment**.
   - The Comments pane is displayed.
3. In the Comments field, type your comment.
4. In the Name field, type your name. (This field is required.)
5. In the Email field, enter the email address to which you want responses sent.
6. In the Security question field, add the numbers and enter the answer in the field.
7. Click **Preview**.
   - Your comment is presented as it will be displayed.
8. To remove your comment, click **Discard**.
   - The comment is discarded and the Comments pane is closed.
9. To post your comment, click **Post comment to public area**.
   - The comment is posted on the conference page.

**Note**

You can send a private comment to the conference host by clicking **Send private comment to host**.
Setting Time Zone (if not already set)

- In Set default time zone, select the time zone for your location.

The Web page is refreshed, and your computer is set to the time zone in which it is located, ensuring that conference events reported on the computer are adjusted to local time. The default time zone is UTC 12:00.

Note
You have to set the time zone only once for your computer. The setting is common to all ShoreTel Conference Web Portal tabs and pages on your computer.

Recordings Page

From here, you can view, play, download, and manage recordings.

The following table describes the fields on the Recordings page:

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Enter string. Click to initiate search.</td>
</tr>
<tr>
<td>Name</td>
<td>Conference name.</td>
</tr>
<tr>
<td>Date</td>
<td>Date and time recording started, and duration.</td>
</tr>
<tr>
<td>Hosted by</td>
<td>Conference host.</td>
</tr>
<tr>
<td>Info</td>
<td>Opens page that provides information about conference.</td>
</tr>
<tr>
<td>Play</td>
<td>Play recording.</td>
</tr>
<tr>
<td>Download (web &amp; audio)</td>
<td>Download data and audio.</td>
</tr>
<tr>
<td>Download (audio only)</td>
<td>Download audio.</td>
</tr>
<tr>
<td>Set default time zone</td>
<td>Specify local time zone. All conference information is adjusted.</td>
</tr>
</tbody>
</table>

System Test Page

From here, you can test your computer to ensure that it can run ShoreTel Web conferences.

Speed Test Page

From here, you can test the latency of the connection between your computer and the ShoreTel system.

Note
For best results, the latency should be under 100ms.
Testing Connection Between your Computer and ShoreTel System

1. Click **Speed Test**.
   The Speed Test page is displayed.

2. Click **Start Test**.
   The test is run and the results are displayed.
This chapter provides instructions for using the ShoreTel conferencing application. It contains the following information:

Overview ............................................................................................................................. 28
Creating Conferences ....................................................................................................... 28
   Set Default Time Zone ................................................................................................. 30
   Invite Conference Participants Through ShoreTel Conference Web Portal .......... 31
   Edit Conferences ........................................................................................................ 32
   View Conference Page Option ................................................................................... 32
Delete a Conference ......................................................................................................... 33
Overview

Conferencing with ShoreTel Communicator is a multi-feature application that can be easily done through the ShoreTel Conference Web Portal.

Creating Conferences

**Note**

You can also create a conference in one click in Microsoft Outlook.

1. Launch ShoreTel Communicator.

2. On the menu bar, click **Windows > Conference Web Portal**.
   
   Your ShoreTel Conferencing portal is launched in a web browser.

3. Click **Set default time zone**.

4. Select the time zone for your geographical location.

5. Click **Add a Conference**.
   
   The Add a Conference page is displayed.

6. In **Conference Name**, enter a name.
   
   The name is referenced in e-mails about conference sessions.

7. In **Date/Time**, specify conference type:
   
   - **Reservation-less**: ad-hoc.
   - **Schedule**: recurring.

8. Select **Start Date**.

9. Select **Start Time**.

   Time is based on default time-zone parameter set for your Conference Viewer.

**Note**

Time is automatically calculated for remote users.

10. Select Duration.

11. For a recurring conference, check **Enable recurrence**, then specify an interval:
- None: One conference.
- Daily: One conference every day.
- Weekly: One conference one day per week.
- Monthly: One conference one day per month.

12. If you want the ShoreTel system to send you an e-mail invitation to the conference, check **Add to my calendar**.

   The e-mail includes links for launching the conference portal and the page for the conference in your calendar.

   You can forward the invitation to others.

13. In **Description**, describe the conference.

   The description is posted in the ShoreTel Conference Viewer.

14. In **Login**, specify a method for accessing the conference:

   - **Name**: participants can access the conference using their names.
   - **Name/Password**: participants can access the conference using their name and the conference password.

15. In **Password**, type the conference password. You can use up to eight characters in the password.

16. In **Dial-in number and Access Code**, enter the information needed to access the conference.

17. In the **Participant Code** field, enter the code that you want call participants to use to access the conference.

18. In the **Host Code** field, enter the code that you want the conference host to use to access the conference.

19. In **Participant Announcement**, select the announcement used when a participant joins or leaves the conference:

   - **None**: no announcement is made.
   - **Tone**: a tone is played.
   - **Detailed**: participants are prompted for their names when joining; names are announced when participants enter and exit.

---

**Note**

This feature is not supported for recurring conferences.

**Note**

The system automatically generates conference access information for every new conference.
20. For more conference options, click **Show more options**.

21. In **Conference Type**, specify how the conference should start:
   - **Start the conference only when host joins**: participants are placed on hold until host joins.
   - **Start the conference only when I join and list the conference on the public page**: host must join conference and place conference information on Conference portal in Public before participants can join.
   - **Start the conference when anyone joins**: conference starts after first person joins.
   - **Start the conference when anyone joins and make everyone a presenter**: conference starts after first person joins, and everyone can present data.

---

**Note**

Conference Type is unavailable for web conference portal page for audio only.

22. In **Outdial Prompt**, specify whether participants (including the host) called from the conference are prompted to join conference:
   - **Require Prompt**: called parties must press 1 to join.
   - **No Prompt**: called parties can join without a prompt.

23. In **Comments**, specify how participants can place comments in conference record:
   - **Allow public comments**: participants can record comments directly into conference record.
   - **Private comments only**: all comments are directed to host for inclusion in conference record.
   - **Disable comments**: participants cannot place comments in the conference record.

24. Click **Submit**.

   Conference is created.

---

**Set Default Time Zone**

The ShoreTel Conference Web Portal clock, the default time zone, is initially set by the ShoreTel Headquarters server.

You must synchronize the clock to your local time zone:

1. Launch the ShoreTel Conference Web Portal.
2. Sign in.
3. Click **My Conferences**.
4. Click **Conference**.

   The date and time you logged in is displayed.
5. Click **Set default time zone** (bottom of page).
   Time zones are displayed.

6. Select your local time zone.
   The page is refreshed, and the time zone is reset.

**Note**
If your computer is taken to another time zone, reset the default time zone to the new, local time.

---

**Invite Conference Participants Through ShoreTel Conference Web Portal**

After a conference is created, you can invite additional participants through the ShoreTel Conference Web Portal or through your default email application.

**Note**
When creating a conference, you can use your Microsoft Outlook contact list to invite additional participants. Your email invitation allows you bring up Microsoft Outlook with the conference invitation information.

**Invite Additional Participants**

1. Launch the ShoreTel Conference Web Portal.
2. Sign in.
3. Click **My Conferences**.
4. Click **Conference**.
5. Select a conference.
6. Click **Invite**.
7. Enter email addresses or email groups. (Separate each entry a comma.)

   The conference name is automatically generated.

   The invitation message is automatically generated.

   The default message contains:
   - Number for audio portion of conference.
   - Participant access code for audio portion of conference.
   - Link for the web portion of conference.
- Password for conference (if required).
- Conference date, time, and duration.

**Note**
To edit the message, highlight text and type new message. The invite also displays whatever is configured in additional calling information.

8. Click **Send Email** or **Open My Email**.

   The email is sent from your default email application.

**Edit Conferences**

For an existing conference, use **Edit** to reschedule a conference, change the description, or change other options.

1. Launch ShoreTel Conference Web Portal.
2. Sign in.
3. Click **My Conferences**.
4. Click **Conferences**.
5. Select a conference.
6. Click **Edit**.

   The View Conference Page is displayed.
7. Enter edits.
8. Click **Submit**.

**Note**
**Reset**: Resets page to original values. **Cancel**: Cancels edit operation.

**View Conference Page Option**

Click **View Conference Page** to display a summary of information about a specific conference.

1. Launch the ShoreTel Conference Web Portal.
2. Sign in.
3. Click **My Conferences**.
4. Click **Conferences**.
5. Select a conference.

6. Click **Edit**.

7. Click **View Conference Page**.

   A page providing information about the conference is opened.

The following table describes the fields on the Conference Information page.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The conference name.</td>
</tr>
<tr>
<td>Hosted by</td>
<td>Identifies the conference host.</td>
</tr>
<tr>
<td>Join</td>
<td>Button that allows you to join the conference now.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>The date the conference was created and the time it is scheduled to meet.</td>
</tr>
<tr>
<td>Duration</td>
<td>Specifies how long the conference sessions are scheduled to meet. Identifies the time zone for which the schedule is calibrated.</td>
</tr>
<tr>
<td>Download iCalendar</td>
<td>Allows you to open the configuration page for the conference in the calendar application in which the conference was created.</td>
</tr>
<tr>
<td>Login</td>
<td>Specifies the requirements for participants to join the conference.</td>
</tr>
<tr>
<td>Telephone</td>
<td>Specifies the phone number participants dial to access the conference. (Often, this number is for external callers.)</td>
</tr>
<tr>
<td>Participant code</td>
<td>Access code participants must use to access the conference.</td>
</tr>
</tbody>
</table>

### Delete a Conference

1. Log in to **My Conferences**.

2. Select a conference.

3. Click **Delete**.

4. Click **OK** (conference is deleted), or **Cancel** (operation is canceled).

**Note**

Participants are not automatically notified when a conference is cancelled.
This chapter provides instructions for joining and hosting a conference through the ShoreTel system. It contains the following information:

Overview ................................................................. 36
Enforced Conference Schedules ........................................ 36
Joining Conferences ...................................................... 36
   Joining Conferences from Email Invitation .................. 36
   Joining Conferences from ShoreTel Conference Web Portal 37
Conference Host ........................................................ 40
   Joining Conferences as Host ....................................... 40
Desktop Sharing .......................................................... 41
Ending a Conference ..................................................... 48
Overview

After a conference has been scheduled, the conference host and participants may join the audio and web conferences in one of four ways:

- Participants can click an email link sent when the host scheduled the conference. The participant may call the conference number listed on the Audio Conference popup screen or have the system call them at a number of their choice.
- A participant can dial directly into an audio conference.
- A host can "conference in a participant" by requesting that the system dial the participant’s number from the Conference Viewer.
- A host can add participants users by using an IP phone and through ShoreTel Communicator.

Enforced Conference Schedules

When the system uses enforced scheduling, conference beginning and end times are enforced when the host does not join the conference. Participants can log into a conference up to 10 minutes before the start time when the host has not joined.

If the host does not join the conference, the conference is automatically terminated at the scheduled end time. Five minutes before the conference is scheduled to end, a termination message is posted on the web pages of participants. At the appointed time, the session is terminated and the participants are redirected to the appropriate website.

Joining Conferences

Participants can join the conference by clicking the email link sent by the host or accessing the conference through the Public tab.

Joining Conferences from Email Invitation

The ShoreTel system can send email messages to parties who are invited to join a conference. The message can include information about the conference, access information for dialing into the conference, and a link for joining the web session of the conference.

1. Open the email invitation sent to you by the conference host.
2. Dial into the conference:
3. “Extension” if dialing from ShoreTel phone system.
4. “Local dial in” number if calling from outside ShoreTel phone system.
The system informs you that you have reached ShoreTel conferencing and asks for the access code to the conference.

5. Type **Participant code**, followed by the pound sign.

   You may be asked to provide your name.

6. Join the web session of the conference: Click the link.

   The default browser is opened on your device and the ShoreTel Conference page is launched.

7. Type your name in the prompt.

8. Click **OK**.

9. Select the method you want to use to dial into the conference.

   - **I'll call this number:** You dial into the audio session of the conference.
   - **Call me at this number:** Type the number where you can be reached; the conference calls you.

10. Click **OK**.

---

**Note**

Click **Cancel** if you have already dialed in or you do not intend to dial into the audio session.

The Conference Viewer appears. Your name is listed among the participants in the Participant pane in the conference session web page.

---

**Note**

For information about using web conference pages, see **Conference Viewer** on page 58.

---

**Joining Conferences from ShoreTel Conference Web Portal**

You can join conferences from **Public** or **My Conference**.

**Joining Conferences from Public**

1. Launch a supported browser.

2. In Address, type the URL for the ShoreTel Conference application (provided by your system administrator).

   The ShoreTel Conference Web Portal is opened.

   Public is displayed for systems that support audio and web conferencing or for systems that support audio only.

3. In Show, select a conference:
- **In-progress conferences**: Display list of conferences in progress.
- **Today's conference**: Display list of all conferences scheduled for today.

4. Click **Go**.
   The page refreshes, listing the conferences.
5. Locate the conference that you want to join.
6. Click the name of the conference.
7. Click **Join**.
   The conference session page is launched.
8. Type your name in the prompt.
9. Click **OK**.
   The Audio Conference dialog box is displayed over the ShoreTel conference session page.
10. Select the method you want to use to join dial the audio session of the conference.
    - **I'll call this number**: You dial into the audio session of the conference.
    - **Call me at this number**: Type the number where you can be reached; the conference calls you.
11. Click **OK**.
   Click **Cancel** if you have already dialed in or you do not intend to dial into the audio session.

   The Conference Viewer for systems that support audio and web conferencing is opened for the conference host or for a conference participant.
   Your name is listed among the participants in the Participant pane in the conference session web page.
   For information about using web conference pages, see [Conference Viewer](#) on page 58.

### Joining or Starting Conferences from My Conferences

1. Launch a supported browser.
2. In Address, type the URL of the ShoreTel Conference application (provided by your system administrator).
   The ShoreTel Conference Web Portal is opened.
3. Click **My Conferences**.
   If you are already signed in, My Conferences is opened.
   If not signed in, you are prompted to enter your ShoreTel ID and password. My Conferences is then opened.
4. Click the name of a conference.

5. Click **Join**.
   
The conference session page is launched, and the Audio Conference dialog box is displayed over the session page.

6. Select a way to dial into the audio session of the conference.
   
   - **I'll call this number**: You dial into audio session of conference.
   
   - **Call me at this number**: Type the number where you can be reached; the conference calls you.

7. Click **OK**.
   
   Click **Cancel** if you have already dialed in or you do not intend to dial into the audio session.

### Joining Conferences Using Access Code

Every conference has an access code for participants and an access code for the host.

- The participant code allows the user to join the conference session. The participant code is provided in the e-mail invitation and the info page for conferences listed on Public.

- The host code allows the user to manage the conference session. The host access code is available in the conference profile.

1. Obtain the participant or host code for the conference.

2. Launch the ShoreTel Conference Web Portal.

3. In Access Code, enter the access code.

4. Click **Join**.
   
   - If the host access code is entered, the host conference page is launched.
   
   - If the participant access code is entered, the participant conference page is launched and the conference is either started or is waiting to start.
   
   - If a participant is informed that there is no conference, the conference is scheduled to start at another time. In this situation, access the conference within five minutes of the scheduled start time or when the host has joined the conference.

### Conference Session Status

When you join a conference session, the session status is displayed in the session web page on the right side of the toolbar:

- **Blank**: The conference is in progress.

- **“It is too early to start”**: Conference is not scheduled to start. Try again later.

- **“Conference started”**: You are the first participant.
“Waiting for conference to start”: You have secured a port but the conference has not started. Wait for the conference to start.

Conference Host

The host is the owner of the conference profile. The host can manage both the profile and conference sessions. When the host joins a conference, the web conference page for the host is displayed on host’s desktop. From there, the host can manage the conference session.

The host can share applications, give permission to participants to share applications, implement recording the session, have the system dial participants, delete participants from the session, end the session, and more.

For information about host Conference Viewer, see Conference Viewer on page 58.

---

Joining Conferences as Host

There are two ways to join a conference as a host:

- Logging in as Host from inside a Conference: You are automatically made the host of the session.
- Logging in as Host from ShoreTel Conference web Portal: You must log in as the host to host the session.

Logging in as Host From Inside a Conference

Requirements

- Your ShoreTel user ID
- Your ShoreTel user password

1. Click Login on the ShoreTel conference toolbar.
   The Login dialog box appears.
2. Enter your ShoreTel user ID.
3. Enter your ShoreTel user password.
4. Click Sign In.
   The browser is refreshed, and the conference host page is opened.
Logging in as Host from the ShoreTel Conference web Portal

1. Access the ShoreTel conference web portal page.
2. In Access Code, enter the host access code.

The Conference Viewer appears and opens to the host web page.

Desktop Sharing

Windows desktops are shared using Windows Presenter. Mac desktops are shared using ShoreTel Presenter for Java.

Initiating Desktop Sharing

1. After starting the conference, click Share on the conference toolbar.
   A drop-down menu is opened.

   Note
   If sharing for the first time on Windows, you are prompted to select ShoreTel Presenter. From here, follow the prompts.

2. Choose Entire Desktop.
   A red “presenter” frame is drawn around your entire desktop.

   See Conference Presenter on page 49 for more information about using presenter frame.

   After desktop sharing is initiated, Presenter provides tools for managing the shared desktop.

Presenter Tools

- Pause: Pause desktop sharing. The central screen is blank until desktop sharing is restarted.
- Show Menu: Open tools for managing the quality of desktop sharing and applications.
- Pointer: Point to items on your desktop or in an application.
- Tools for Managing Image Quality and Screen Resolution:
  - Refresh Rate: Determines how much data is transmitted. Options are low, medium, and high. Default is medium.
  - Image Quality: Determines the image quality of data. Options are low, medium, and high. Default is medium.
  - My Screen Resolution: Determines the resolution of your screen. Options include Original, 1024X768, and 800X600. Setting the resolution can impact how participants see your desktop sharing. Default is Original.
Sharing Help: Explanation for desktop sharing tools.

Close: Close desktop sharing.

Choose Sharing Window: Determines how much of your screen you share. Select the application you want to share, or manipulate the presentation area you want to share.

**Ending Desktop Sharing**

- Click **Stop** icon or **Stop** button on toolbar.
- You can also select **Close** to end desktop sharing.

**Share Files from Conference Library**

- Files stored in the ShoreTel conference web portal library can be shared during conferences. The files can be uploaded to a user’s public space (shared library) or personal space (personal library). Files uploaded to the public space can be used by anyone presenting in a conference. Files uploaded to a private space can be used only by the owner of the personal library.

**Sharing a file from the library**

1. Click the Share button on the toolbar.
   
   The Share menu is displayed.

2. Click **Personal Library** or **Shared Library**.
   
   - Personal Library: Files uploaded to your personal library in the ShoreTel Conference Web Portal.
   - Shared Library: Files uploaded to your public library in the ShoreTel Conference Web Portal.

   A list of files is displayed.

**Note**

If you are not the host, you must sign into the conference in order to display the Personal Library option.

3. Click the file that you want to share.
   
   The file is opened in the Conference Viewer.

   The integrated page is displayed.

**Integrating Presentations**

When slides from a PowerPoint presentation are imported into the conference session, you use the ShoreTel conference web page to present the presentation.
Presentations are handled independently of each other. When multiple presentations are imported into a conference session, only one presentation is loaded into the conference session page at a time. The presentation is available to all conference participants having presentation privileges.

**Changing or Displaying a Slide**

1. Locate the field providing information about the presentation between Share and More on the toolbar.
2. Click the right arrow to advance to the next slide.
3. Click the left arrow to move to the previous slide.
4. Click the field and select the slide that you want to display.

   The screen is refreshed, and the slide is displayed.

**Using Whiteboard Tools**

1. Select a tool.
2. Move the cursor to the point where you want to start marking.
3. Click and drag the mouse as necessary.

   Marks are retained until the presentation is closed.
   Marks cannot be saved directly, but you can record the web conference session.

   To adjust the size of the presentation in the web page, click the field to the right of More on the toolbar and select the screen size that you want to use for displaying slides.

4. To clear the page without stopping share, click **Stop**.

**Whiteboard**

- Presenters can use the whiteboard to create and share drawings.
- Drawings have basic drawing forms (lines, shapes, text, color, and a pointer).
- Drawings can be recorded during a conference.
- Drawing control can be passed from host to participants.
- Multiple whiteboards can be created in the same conference.
- Whiteboards can be deleted, but one whiteboard is always open.
- Stopping a conference cleans up all whiteboard sessions.
- Objects can be moved in the whiteboard.
- You can erase a single object or the entire whiteboard.
Accessing the Whiteboard

1. Open the conference as host.
2. Click Share.
   The drop-down menu is opened.
3. Click Whiteboard.
4. The whiteboard tools are opened on the left side of the Conference Viewer.
5. To add an additional whiteboard, click + on the toolbar.
   The arrow keys on either side of the drop-down menu allow you to scroll through available whiteboards.

**Note**
To save a whiteboard, record the conference.

Deleting a Whiteboard

Whiteboards are automatically deleted when you leave a session.

**Manually Deleting a Whiteboard:**
1. In the field that identifies the whiteboard that is being displayed, select the whiteboard.
2. Click the - (minus sign) icon.
   A confirmation message is displayed.
3. Click Yes.
   The page is refreshed, and another whiteboard is opened, or the Share Desktop page is displayed.

Restoring Whiteboard Sharing

You can stop sharing the whiteboard during a conference session; the whiteboard is removed from the viewer.

You can restore the whiteboard at any time; the latest changes are displayed.

Stopping Whiteboard Sharing

- Click Stop.
  The conference page is refreshed, and the Start desktop sharing page is displayed.
Restoring Whiteboard Sharing

- Click Share > Whiteboard.

The whiteboard is restored in the viewer.

Chat Messaging

The conference host can send messages to everyone in the conference or to individual participants. A participant’s reply can be viewed by all of the conference participants or by an individual participant.

Sending a Chat Message

1. Type the message in the message area.
2. Choose the recipient from the drop-down menu.
3. Click the arrow to send the message.

Note
To view messages, open the message window.

Presenter Control

During a conference, the host can delegate presentation controls to any participant. The participant can then control the following:

- Screen share
- Whiteboard drawing
- Library share
- Send or upload file
- Import presentations (Windows only)

Note
A host cannot pass audio control to a participant. After a host passes presentation control to a participant, the host continues to control the participant list (mute, lock etc.).

Delegating Presenter Control

1. Highlight a participant.
2. Click Participant Options.
   The menu is opened.
3. Select Allow Presenting.
The participant is sent a message prompting for desktop sharing.
Control is delegated if the participant clicks Yes.

**Ending Presenter Rights**

1. Highlight the participant.
2. Click the **Participant Options**.
   The menu is opened.
3. Select **Discontinue Presenting**.
   The participant is sent a message indicating that the host is taking back control.

**Recording a Conference**

- Only a host can record conference sessions.
- A recording can be started and stopped at any point during the session.
- Multiple recordings can be made of the same session.
- Each recording is assigned a recording ID and is listed under the recording tab in the web conference portal for the conference.
- When web conferencing is enabled, audio and web portions of the conference are recorded.

---

**Note**

You can record up to eight consecutive hours in a conference.

**Starting Recording From a Web Conference Portal**

By default, the name of the recording is the same as the name of the conference.

1. Join a conference as the host.
2. To ensure that the audio portion of the conference is recorded, dial into the conference or make sure that someone is dialed into the conference.

---

**Note**

Stopping the ShoreTel desktop sharing or any streaming application is required before you can start recording.

3. Click **More > Start Recording**.
   A prompt on the audio session informs participants that the call is being recorded.
When there is no audio session, a message is displayed to inform the host that only a web session is being recorded.

4. Click OK.

Recording is continued.

When desktop sharing is in progress, a message is displayed to inform the host that desktop sharing must be stopped or paused to start the recording.

5. Click OK.

Desktop sharing is stopped.

After the recording is started, restart desktop sharing.

The Stop Recording button is displayed on the menu bar.

**Stopping a Recording From a Web Conference Page**

1. Click More > Stop Recording, or click the Stop Recording button.

   The stop recording message dialog is opened.

2. Click OK.

   A confirmation message dialog is opened.

3. Click OK.

**Note**

When you stop a recording, only the recording is stopped; the audio and web sessions continue.

**Managing a Recording From an Phone**

- A host can start and stop a recording using the keypad of a ShoreTel phone. Both audio and web portions of the conference are recorded. To use the ShoreTel phone to start and stop recording a conference:

1. Join the conference as the host.

**Note**

Use the host access code when dialing into the conference.

2. On the keypad, press # then 4.

   The audio participants are informed that the conference is being recorded.

3. To stop the recording, press # then 4.

   The audio participants are informed that the recording has stopped.
Ending a Conference

Only the host can end a conference. If the host does not participate in a conference or leaves early, the conference is terminated after the last participant exits. Participants may leave a conference at any time. Participants are not required to log out of a conference. To leave a conference, close the conference browser window.

1. Join the conference as host.

1. Click **More > End Conference**.
   
   A confirmation message box is opened.

2. Click **OK**.
   
   Participants are notified, and the conference is ended.
Conference Presenter

This chapter provides instructions for using the ShoreTel conference presenter. It contains the following information:

- Overview ................................................................................................................... 50
- ShoreTel Presenter for Windows ............................................................................... 50
  Installation ........................................................................................................... 50
- ShoreTel Presenter for Java ...................................................................................... 51
  Requirements ..................................................................................................... 51
  Installing ShoreTel Presenter on an Apple Macintosh ........................................ 52
- ShoreTel Presenter ................................................................................................... 52
  Launching Presenter .......................................................................................... 52
  Presenter menu .................................................................................................. 53
  Sharing Windows Options .................................................................................. 54
  Setting the Sharing Resolution ........................................................................... 55
  Adjusting Quality of Shared Image ..................................................................... 56
  Adjusting the Outgoing Bandwidth ...................................................................... 57
Overview

ShoreTel Presenter enables a conference participant to share desktop content with other conference participants. Sharing is possible only if Presenter is installed on the computer sharing the desktop and the computer(s) receiving the shared content. (Presenter is automatically installed with ShoreTel Communicator.) Only one participant can present at a time. Depending on the configuration of the conference, the default presenter is the host. (The host can give permission to other participants to share their desktop, or the conference can be configured so any participant can share.)

ShoreTel supports two presenter applications

- ShoreTel Presenter for Windows
- ShoreTel Presenter for Java

They provide the same basic features and functions.

ShoreTel Presenter for Windows

Installation

Requirements

- ShoreTel Web Conferencing service
- A web browser:
  - Microsoft Internet Explore 9.0
  - Firefox 5.0 or later
  - Safari 5.0 or later
- Adobe Flash 9 or later
- Java 1.6.0.15 Runtime Environment or later

Installing ShoreTel Presenter for Windows

1. Download the Java RunTime Environment.
2. Install Presenter.
Installing ShoreTel Presenter for Windows using ShoreTel Conference Web Portal

Download and install ShoreTel Presenter for Windows on the computer used for desktop sharing (if Presenter for Windows is not pre-installed via Communicator).

1. Launch your Web browser.

2. In the address field, type the URL for your company ShoreTel conference Web portal.
   (If you do not know the URL, contact your ShoreTel system administrator.)
   The Public tab of the ShoreTel conference Website appears.

3. Click Download.
   The Download page appears. You can also access this page from the My Conference tab by clicking Download Presenter Software.

4. Click Download ShoreTel Presenter.
   The File Download Security Warning dialog box appears.

5. Click Run.

6. Presenter for Windows is downloaded.
   The ShoreTel Presenter Installation Wizard appears.

7. Follow the prompts.

ShoreTel Presenter for Java

ShoreTel Presenter for Java provides an alternative way to share a desktop on Windows, without having to install any software.

Note
The ShoreTel Presenter for Java also provides the only way to share Mac desktops. The ShoreTel Presenter for Java does not allow desktop sharing on a secondary monitor or desktop sharing across multiple monitors.

Requirements

- ShoreTel Web Conferencing service
- A web browser:
  - Microsoft Internet Explore 9.0
Firefox 5.0 (supports Windows and Mac operating systems)
- Safari 5.0
  - Adobe Flash 9 or later
  - Java 1.6.0.15 Runtime Environment or later.

This software must be downloaded on a participant’s computer to participate in desktop sharing.

Installing ShoreTel Presenter on an Apple Macintosh

1. Download the Java RunTime Environment.
2. Install Presenter.

ShoreTel Presenter

Launching Presenter

1. Join a conference as the host, or join a conference that allows all participants to share the desktop.
2. In the Start Sharing Desktop page, click the button to start sharing your desktop.
   
   The ShoreTel Presenter Software dialog box is opened.

   Note
   To launch an alternative presenter, press Shift and click the button to start sharing your desktop.

3. Select a default ShoreTel Presenter:
   - Click Windows Presenter.
     
     This is recommended for computers using Windows.
   - Click Java Presenter.
     
     You must select this option for Mac computers. You can also use this option for Windows computers.
     - Click Remember my selection.
       
       Your selection is used as the default presenter launched on this computer for desktop sharing.
     - Click OK.
Presenter menu

The Presenter menu for Windows is different from the Presenter menu for Java.

Table 12 lists the options that are available using ShoreTel Presenter for Windows.

Table 12: ShoreTel Presenter for Windows show menu options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start sharing</td>
<td>Start (or resume) desktop sharing.</td>
</tr>
<tr>
<td>Pause sharing</td>
<td>Pause sharing.</td>
</tr>
<tr>
<td>Disable Desktop Accelerator (SDA)</td>
<td>The Deskshare Accelerator (SDA) helps render conference content. It is installed with ShoreTel Communicator for Windows. (It can also be installed independently.) If SDA conflicts with other accelerator programs installed on your computer, nothing is shared. Disable SDA under these circumstances.</td>
</tr>
<tr>
<td>Refresh rate</td>
<td>Low (low bandwidth).</td>
</tr>
<tr>
<td></td>
<td>Medium.</td>
</tr>
<tr>
<td></td>
<td>High (high bandwidth).</td>
</tr>
<tr>
<td>Image quality</td>
<td>Low (low bandwidth).</td>
</tr>
<tr>
<td></td>
<td>Medium.</td>
</tr>
<tr>
<td></td>
<td>High (high bandwidth).</td>
</tr>
<tr>
<td>My Screen Resolution</td>
<td>Original (default).</td>
</tr>
<tr>
<td></td>
<td>1024 × 768.</td>
</tr>
<tr>
<td></td>
<td>800 × 600.</td>
</tr>
<tr>
<td>Show More Menu</td>
<td>Expand or contract menu options.</td>
</tr>
<tr>
<td>Sharing Help</td>
<td>Help system.</td>
</tr>
<tr>
<td>Close</td>
<td>Close Presenter; end desktop sharing.</td>
</tr>
</tbody>
</table>

Table 13 lists the options that are available for ShoreTel Presenter for Java.

Table 13: ShoreTel Presenter for Java drop-down menu options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start sharing</td>
<td>Start (or resume) desktop sharing.</td>
</tr>
<tr>
<td>Pause sharing</td>
<td>Pause sharing.</td>
</tr>
</tbody>
</table>
Sharing Windows Options

The sharing area is automatically adjusted when the presenter screen-size setting is changed. The size and position of the sharing area can be manually adjusted.

**Note**

This option is not available in ShoreTel Presenter for Java.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image quality</td>
<td>Low (low bandwidth).</td>
</tr>
<tr>
<td></td>
<td>Medium.</td>
</tr>
<tr>
<td></td>
<td>High (high bandwidth).</td>
</tr>
<tr>
<td>Sharing size</td>
<td>Entire screen (at default resolution).</td>
</tr>
<tr>
<td></td>
<td>1024×768, 800×600, 640×480.</td>
</tr>
<tr>
<td>Close</td>
<td>Close Presenter; end desktop sharing.</td>
</tr>
</tbody>
</table>

### Specifying an Application to Display in ShoreTel Presenter for Windows

1. Click **Choose Sharing**.
2. Select an application
   
   The application is outlined in red.

### Modifying Sharing Area in ShoreTel Presenter for Windows

1. Click **Choose Sharing**.
2. Click **Rectangular Area**.
   
   The sharing area is displayed in the middle of the screen.
   
   The icons are located in the top, left-hand corner.
3. To move the sharing area:
   a. Place the cursor on the border.
      The Move tool is opened.
   b. Hold down the right mouse button, then drag the sharing area to another position.

4. To modify the size of the sharing area:
   a. Place the cursor in one of the corners.
      The double-arrow Move tool is opened.
   b. Hold down the right mouse button, then stretch or shrink the sharing area.

Repositioning Sharing Area in ShoreTel Presenter for Java

In ShoreTel Presenter for Java, you can reposition the sharing area when changing the resolution. Only content displayed in the frame on the sharing desktop is broadcast to conference participants.

1. Click Show Menu.

2. Select Sharing Size, then select the resolution.
   The sharing area is refreshed in the center of the desktop.

3. To reposition the sharing area:
   a. Place the cursor on the border.
      The Move tool is opened.
   b. Hold down the right mouse button, then drag the sharing area to another position.

Setting the Sharing Resolution

By default, the entire desktop is shared using the resolution configured for the display of the sharing computer. For example, if the resolution of the sharing computer is 1280×1024, the resolution of the shared desktop is 1280×1024.

Participants using displays set for a different resolution experience resolution mismatch. Participants using higher resolution receive the image as sent, with reduced detail. Participants using lower resolution may experience degraded image quality.

To accommodate lower resolution, Presenter allows participants to temporarily override the display resolution settings of the sharing computer. When the override is invoked, Presenter changes the current display resolution. When Presenter is closed, the resolution reverts to the configured setting.

The image exported by Presenter is displayed in a frame in the Web conference session page.
Changing Resolution of ShoreTel Presenter for Windows

1. Click Show Menu.
   The menu appears.

2. Select My Screen Resolution > resolution value.
   - The resolution value applies to the conference.
   - The screen refreshes to the selected resolution.
   - Images on the desktop are recalibrated to the new resolution.
   - Participants see the sharing area.
   - If necessary, resize the presented application to ensure that participants can see an entire image.
   - All opened applications are automatically resized to the new resolution.

Changing Resolution of ShoreTel Presenter for Java

1. Click Show Menu.
   The menu appears.

2. Select Sharing Size > resolution value.
   - The resolution value applies to the conference.
   - The screen refreshes to the selected resolution.
   - Images on the desktop are recalibrated to the new resolution.
   - Participants see the sharing area.
   - If necessary, resize the presented application to ensure that participants can see an entire image.
   - All opened applications are automatically resized to the new resolution.
   - The resolution of the sharing computer is unaffected.

Adjusting Quality of Shared Image

Presentations requiring frequent screen updates (such as animation) often use large amounts of bandwidth. Presenter provides options for improving the participant experience, including adjusting the outgoing refresh rate and bandwidth of the sharing source.

Note
Actual adjustment depends on the input from the source, and can be negligible.
Adjusting Outgoing Refresh Rate for Presenter for Windows Only

1. Click Show Menu.
   
The Show Menu drop-down menu is opened.

2. Select the Refresh Rate:
   
   - Low: half the current rate.
   - Medium: current rate.
   - High: 1.5 times the current rate.

Adjusting the Outgoing Bandwidth

1. Click Show Menu.
   
The Show Menu drop-down menu is opened.

2. Select Image Quality.
   
   - Low: half the current rate.
   - Medium: current rate.
   - High: 1.5 times the current rate.
This chapter provides instructions for using the ShoreTel Conference viewer. It contains the following information:

- Overview ................................................................................................................... 59
- Host Web Conference Page ..................................................................................... 59
  - Share Menu ........................................................................................................ 60
  - More menu ......................................................................................................... 61
- Displaying the More Menu ..................................................................................... 62
- Participant Panel .................................................................................................... 64
- Audio Conference Options ..................................................................................... 65
- Sharing ................................................................................................................. 67
Overview

The Conference Viewer allows the host and participants to join and manage conferences.

The host uses the Conference Viewer to manage the conference.

Participants can use the Web page to interact with the host and view the data shared in the conference.

This chapter provides information about the Web conference page.

Host Web Conference Page

The host has several options available to it to manage re-share Web Conference.

Table 15 describes the host Web conference page.

<table>
<thead>
<tr>
<th>Number</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Share</td>
<td>Specify the application to share with conference participants.</td>
</tr>
<tr>
<td>2</td>
<td>Stop Desktop Sharing</td>
<td>Stop data sharing without closing Web conference.</td>
</tr>
<tr>
<td>3</td>
<td>More</td>
<td>Options for managing conference.</td>
</tr>
<tr>
<td>4</td>
<td>Conference Information</td>
<td>Displays conference details.</td>
</tr>
<tr>
<td>5</td>
<td>Number of Web Attendees</td>
<td>Participants logged in to Web portion of conference.</td>
</tr>
<tr>
<td>6</td>
<td>Number of Audio Attendees</td>
<td>Participants logged in to audio portion of conference.</td>
</tr>
<tr>
<td>7</td>
<td>Help</td>
<td>Conference help system.</td>
</tr>
<tr>
<td>8</td>
<td>Information</td>
<td>Conference details.</td>
</tr>
<tr>
<td>9</td>
<td>Participant</td>
<td>Conference participants.</td>
</tr>
<tr>
<td>10</td>
<td>Participant Options</td>
<td>Participant options.</td>
</tr>
<tr>
<td>11</td>
<td>Audio Conference Options</td>
<td>Audio conference options.</td>
</tr>
<tr>
<td>12</td>
<td>Name</td>
<td>Names of participants.</td>
</tr>
<tr>
<td>13</td>
<td>Phone</td>
<td>Phone number of audio participants and caller ID of Web-only participants.</td>
</tr>
<tr>
<td>14</td>
<td>Message</td>
<td>Displays text and other messages sent during conference.</td>
</tr>
<tr>
<td>15</td>
<td>Message</td>
<td>Enter and send text to conference participants.</td>
</tr>
<tr>
<td>16</td>
<td>Send to</td>
<td>Specify participant to send message.</td>
</tr>
</tbody>
</table>
Share Menu

The Share menu is available to the host or participants with permission to share. From here, designated hosts and participants specify what to share with other conference participants.

Displaying the Share Menu

1. Join a conference as the host (or receive permission to present).
   The Share menu is displayed on the toolbar.

2. Click Share.
   The Share menu is opened.
   The following table lists the Share menu options.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entire Desktop</td>
<td>Launch Presenter and share your desktop with conference participants.</td>
</tr>
<tr>
<td>Personal Library</td>
<td>Share material uploaded to your personal conference library.</td>
</tr>
<tr>
<td>Shared Library</td>
<td>Share material uploaded to the shared conference library.</td>
</tr>
<tr>
<td>Send File</td>
<td>Send a file as a message to conference participants. Participants can choose to open the message or save it.</td>
</tr>
<tr>
<td>Whiteboard</td>
<td>Use conference page as a whiteboard. Whiteboard tools are available for the presenter only.</td>
</tr>
<tr>
<td>Import Presentation</td>
<td>Import Powerpoint presentations into conference. You must first stop sharing to import the presentation. After a presentation is uploaded, sharing starts automatically.</td>
</tr>
</tbody>
</table>

Sharing a Desktop

Conference participants (including the host) who are presenting can share their desktop.

Note
To share the desktop, your computer must be running ShoreTel Presenter for Windows or Java Runtime Environment 1.6.0.15 or later.

Enabling Sharing as a Host

1. Join a conference as the host.

2. Click Share > Entire Desktop, or the sharing button.
Transferring Sharing to a Participant

Unless the conference is configured to allow participants to share when they join, the host must grant share privilege to participants.

When sharing is granted from the beginning of a conference, the host can revoke and restore the share privilege.

1. Join a conference as the host.

2. In Participant, select a participant.
   - The participant must have a Web connection.

3. Click Participant options.
   - The Participant options menu is opened.

4. Click Allow presenting.
   - A dialog is opened on the desktop of the participant noting that the host is granting Presenter control.
   - The participant must click OK to complete the transfer.

Enabling Sharing as a Participant

1. If you are granted permission to present, the Share Desktop dialog is opened on your desktop and the Share menu is displayed on your toolbar.

2. Click Yes.

   Note
   If another participant is currently presenting, a second dialog is opened, identifying the presenter and allowing you to stop the sharing. Click Stop.
   - The Share Desktop dialog is displayed in the middle of the Conference Viewer.

3. Click Start Sharing.

More menu

The More menu is available to the host or participants with permission to share. From here, designated hosts and participants manage audio participants.

Note
This menu does not apply to audio callers using ShoreTel Communicator to access the Web page.
Displaying the More Menu

1. Join a conference as the host.

2. Click **More**.

   The More menu appears.

   The following table lists the More menu options:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute All</td>
<td>Place all participants on mute. Host, if present on call, is never muted by this function.</td>
</tr>
<tr>
<td>Unmute All</td>
<td>Undo mute.</td>
</tr>
<tr>
<td>Call Participant</td>
<td>Dial number of participant to join the audio conference associated with current Web conference.</td>
</tr>
<tr>
<td>Call Me</td>
<td>Dial your extension to join audio conference associated with current Web conference.</td>
</tr>
<tr>
<td>Send Invitation</td>
<td>Send e-mail invitation to join conference. Invitation includes conference information automatically. You must enter the e-mail addresses of participants.</td>
</tr>
<tr>
<td>Record Conference</td>
<td>Record conference.</td>
</tr>
<tr>
<td>Locked Conference</td>
<td>Limit conference participants to those already in attendance. Those trying to join locked conferences receive a prompt indicating that conference is is closed to new participants.</td>
</tr>
<tr>
<td>Restart Conference</td>
<td>Restart the conference. Current members are re-entered automatically. Note: If host service appliance is operating at capacity for Web user when host restarts conference, Web participants are redirected to ShoreTel conference Web portal and receive the error message: &quot;Web capacity is full on this Service Appliance. Please try again later.&quot; Participants must manually re-enter Web session.</td>
</tr>
<tr>
<td>End Conference</td>
<td>End conference.</td>
</tr>
</tbody>
</table>

Sending Email Invitations

The conference host can send email invitations from a conference session. The invitation uses the ShoreTel email template, which includes dialing and access information for the current conference.

1. Click **More > Send Invitation**.

   The Send Invitation dialog is opened.

2. Enter email addresses (separate addresses with commas).

3. Enter text.
4. Click **Send Email** to use the email server of the ShoreTel system to send the email. Or, click **Send From Default Email Application** to use the default email application installed on the current computer to send the invitation.

5. Click **Cancel** to close the dialog and discard the email.

**Recording Conferences**

The host can record conferences. A recording can be started and stopped at any point during the conference, and multiple recordings can be made of the same conference. Each recording is assigned a recording ID and listed under the recording tab in the Web conference portal for the conference. Both audio and Web portions of the conference are recorded.

---

**Note**

You can record up to eight consecutive hours in a conference.

**Starting a Recording from a Web Conference Page**

1. Join a conference as the host.

2. Dial into the conference, or make sure that someone has dialed into the conference.

---

**Note**

You must stop ShoreTel desktop sharing or any streaming application before you can start recording.

3. Click **More > Start Recording:**

   An audio prompt informs participants that the call is being recorded.

   When there is no audio session, a dialog is opened informing you, the host, that only a Web session is being recorded. Even if a caller joins the conference later, the system records the web portion only. Click OK to continue.

   When desktop sharing is in progress, a dialog is opened informing you that desktop sharing must be stopped or paused to start the recording. Click OK to stop desktop sharing. After the recording starts, resume desktop sharing.

4. The recording is started.

   The Stop Recording button appears on the menu bar.

**Stopping a Recording From a Web Conference Page**

1. Click **More > Stop Recording**, click **Stop Recording**.

   The stop recording dialog appears.

2. Click **OK**.
A confirmation dialog appears.

**Starting and Stopping a Recording Using a Phone**

A host can start and stop recording using the keypad of a ShoreTel phone.

1. Join the conference as the host.
   Use the host access code when dialing into the conference.
   A prompt informs all of the audio participants that the conference is being recorded.
3. To stop the recording, press # 4.
   A prompt informs all of the audio participants that the recording has stopped.

**Note**

When you stop a recording, only the recording is stopped; the audio and Web conference continue.

**Participant Panel**

This pane shows the names of conference attendees. The Participant Panel on the host desktop shows how participants joined the conference. From here, the host can manage participants.

**Participant Options**

The Participant options allow the host to manage the Web session of a selected participant. (The participant must have an established Web connection.)

The host can manage desktop sharing and whiteboard use.

The host can also end the Web session of a participant.

1. Log into a conference as the host.
2. In the Participant panel, select a Web session participant.
   The Participant Options are enabled.
3. Click **Participant Options**.
   The Participant Options drop-down menu is opened.
4. Click an option.
   It is applied to the participant, and the icon for the option is posted next to the name of the participant in the Participant panel.

The following table lists the participant options.
Audio Conference Options

The audio conference options allow the host to manage the audio portion of the conference for a selected participant. The host can call members to join the audio session, and manage the audio of a selected participant.

Inviting a Participant to an Audio conference

1. Log into a conference as the host.
2. In the Participant panel, click Audio Conference Options.
   The Audio conference Options menu is opened.
3. Click an option.
   A dialog is opened.
4. Enter the number of the party.
5. Click OK.
   The system dials the number.

Managing Audio Connection of a Participant

1. Log into a conference as the host.
2. In the Participant panel, select an audio session participant (as indicated by a phone next to the name of a participant).
1. Click Audio Conference Options.
   The Audio Conference Options drop-down menu is opened.
2. Click an option.
   It is applied to the participant.

Table 19 provides information about the Audio Conference Options menu.

### Table 18: Participant Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow presenting</td>
<td>Allow participant to present.</td>
</tr>
<tr>
<td>Discontinue</td>
<td>End participant presentation.</td>
</tr>
<tr>
<td>drawing</td>
<td>Allow participant to use whiteboard. (Host must enable whiteboard first.)</td>
</tr>
<tr>
<td>Discontinue</td>
<td>End participant whiteboard use.</td>
</tr>
<tr>
<td>drawing</td>
<td>Remove participant from conference Web session.</td>
</tr>
</tbody>
</table>
Table 19: Audio conference options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Me</td>
<td>Dial phone number of host to attend audio session of conference.</td>
</tr>
<tr>
<td>Call Participant</td>
<td>Dial participant s to attend audio session of conference.</td>
</tr>
<tr>
<td>Mute Phone</td>
<td>Mute phone of participant.</td>
</tr>
<tr>
<td>Unmute Phone</td>
<td>Unmute phone of participant.</td>
</tr>
<tr>
<td>Hang up</td>
<td>Hang up phone of participant.</td>
</tr>
</tbody>
</table>

Participant Web Conference Page

Participants with share capabilities can manager the web conference.

Table 20 describes the host Web conference page.

Table 20: Web Conference Page for Participants with Share Capability

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share Menu</td>
<td>Allows host to specify application shared with conference participants.</td>
</tr>
<tr>
<td></td>
<td>Available only when host grants permission to participant to share desktop.</td>
</tr>
<tr>
<td>Stop Desktop Sharing</td>
<td>Stops sharing, without closing Web conference. Available only when host</td>
</tr>
<tr>
<td></td>
<td>grants permission to participant to share desktop.</td>
</tr>
<tr>
<td>Mute</td>
<td>Mute phone.</td>
</tr>
<tr>
<td>Raised Hand</td>
<td>Draw host's attention.</td>
</tr>
<tr>
<td>Call Me</td>
<td>Conference dials participant phone number.</td>
</tr>
<tr>
<td>Conference Information</td>
<td>Displays information about conference.</td>
</tr>
<tr>
<td>Login (into Web portal)</td>
<td>Take host control of your own conference</td>
</tr>
<tr>
<td>Help</td>
<td>Help system.</td>
</tr>
<tr>
<td>Information</td>
<td>Information about conference and host.</td>
</tr>
<tr>
<td>Participant</td>
<td>Lists conference participants and shows status participant participation.</td>
</tr>
<tr>
<td>Name</td>
<td>Participants names.</td>
</tr>
<tr>
<td>Phone</td>
<td>Lists phone numbers of audio participants and caller ID of Web-only</td>
</tr>
<tr>
<td></td>
<td>participants.</td>
</tr>
<tr>
<td>Message (pane)</td>
<td>Displays text and other messages sent during conference.</td>
</tr>
<tr>
<td>Message (field)</td>
<td>Enter text sent to conference participants.</td>
</tr>
<tr>
<td>Send to</td>
<td>Name of conference participant.</td>
</tr>
</tbody>
</table>
Sharing

Downloading the Library File for a Conference

Conference presenters can download files stored in the ShoreTel Web conferencing library to share with participants. The files can reside in your personal library or the shared library.

1. Join the Web session of a conference.

2. Obtain presenter privilege.
   The Share menu is opened on your Conference Viewer.

3. Click Share.
   The Share menu is opened.

4. Click the library type.

5. Click a file.
   The file opens in the Conference Viewer.

Note
If you are not the host of the conference, you must sign in to access files in your personal library. You are reconnected to the conference with a new status.

Note
If you are not the host, you must sign into the conference before the Personal Library option is opened.

Sending a File

You can send a file to participants for viewing or downloading at their convenience during the conference.

1. Join a conference and secure share privileges.

2. Click Share.
   The Share menu is opened.

3. Click Send File.
   The Select a file to upload dialog is opened.

4. Select a file.

5. Click one of the following options:
- Open: Opens the file on the computer.
- Download: Downloads the file to current computer.
- X: Closes the dialog box.

**Note**
You can access the file any time during the conference by clicking the link.

**Importing Presentations Using the Whiteboard**
- The Import Presentation option allows you to import PowerPoint files into the whiteboard. From there, you can mark presentations in real time. When a PowerPoint file is imported, the slides are transferred to the whiteboard in the conference session.
- The whiteboard tools are displayed with presentation slides on the conference page.
- The conference toolbar is modified to allow you to select a PowerPoint slide for display.
- All participants can use whiteboard tools to select and mark displayed slides.
- Modifications made to the slides using the whiteboard tools are retained as long as the conference is in session.
- The presenter can import multiple PowerPoint files for a single conference session.
- The names of the files imported by the presenter are listed in the Share menu of the presenter only.
- Only one file at a time is loaded for viewing into the Conference Viewer.
- Files can be used as long as the conference is in session, even if the presenter leaves.

**Importing and Using PowerPoint file in Web Conference Session**
1. Join a conference and secure share privilege.
2. Click **Share**.
   The Share menu is opened.
3. Click **Import Presentation**.
   The Select File dialog is opened.

**Note**
You may be prompted to stop desktop sharing. If so, click **OK**; click **Stop** (on the toolbar); then click **Share > Import Presentation**.
4. Select a PowerPoint file.
PowerPoint is launched in the background on the computer and the presentation slides are loaded and integrated into the whiteboard in the conference session.

After the slides are loaded, you can close the PowerPoint application.

When multiple PowerPoint presentations are uploaded, the presenter must select the file as follows: Click **Share**, then select the file.

**Selecting a Single Slide for Display**

1. On the toolbar, navigate to the slide select.
2. In the page field, click and select a page.

   The page appears.
This chapter provides instructions for using the ShoreTel Instant conferencing application. It contains the following information:

- Overview ................................................................................................................... 71
- Requirements............................................................................................................ 71
- Configuring Data Collaboration Session ............................................................... 71
Overview

This chapter describes the installation, configuration and utilization of instant conferencing.

Requirements

Install one of the following on the ShoreTel Communicator computer for presentation:

- ShoreTel Presenter for Windows
- Java Run Time Environment 1.6.0.15 or later

Configuring Data Collaboration Session

1. Establish a call with ShoreTel participants.
2. Call participants launch ShoreTel Communicator on their computers.
3. One user, the host, clicks the Start Instant Conference icon on the bar in Communicator showing the call. (You can also click Call > Start Instant Conference on the toolbar.)

A link for the conference appears in the call cell. The link shows the Web address and the conference ID number. Also, if configured to do so (the default value), the link is automatically activated on all participant machines and the Conference Viewer is launched.

4. Click the start button in the Conference Viewer to start desktop sharing. Control of the desktop can be transferred to another user at any time.

The Launch Application dialog box will appear.

5. Do one of the following:

- Click VPresent to share your desktop.
- Click Choose to select the application that you want to share. See x for information about uploading applications.

Click OK. ShoreTel conference presenter launches. The conference presenter appear as thick border that encases your desktop or the application you select. The conference presenter appears in the Web page that is launched when participants join the Web conference.

The desktop or application that you are sharing is encased in a thick border with four buttons at the top center. The buttons allow you to pause sharing, close sharing, show the share menu, and choose a specific window to share.
Note
To save time and avoid a security warning from the browser, check the Remember my choice for present links check box.
This chapter provides instructions for using the ShoreTel conferencing application with Apple iOS. It contains the following information:

Overview ................................................................................................................... 74
Setting Up the ShoreTel Conferencing App .............................................................. 74
  Installing the Conferencing App ........................................................................ 74
  Configuring the Conferencing App .................................................................. 74
Hosting and Joining a Conference ......................................................................... 74
  Hosting a Conference ......................................................................................... 75
  Joining a Conference ........................................................................................ 75
Working with the Conference Screen .................................................................... 75
Viewing Conference Information .......................................................................... 76
  Viewing the List of Participants ........................................................................ 76
Presenting .................................................................................................................. 77
Viewing Presentations ............................................................................................. 77
  Viewing Files ....................................................................................................... 78
Messaging .................................................................................................................. 78
  Sending a Message ............................................................................................. 78
  Receiving a Message ......................................................................................... 78
Conference Actions .................................................................................................. 79
CDMA Devices ........................................................................................................ 80
Overview

Using the ShoreTel Conferencing app, you can attend and host previously created ShoreTel Conferences from your iPhone or iPad.

Setting Up the ShoreTel Conferencing App

Before you can start using the ShoreTel Conferencing App, you must first install and configure the app.

Installing the Conferencing App

The ShoreTel Conferencing app is available from the Apple App Store.

If the Conferencing app is not already installed, clicking a conference link in an email, calendar, or the Conference Web Portal on your iOS device automatically opens the ShoreTel Conferencing app in the App store.

For more information about finding and installing apps, see the Apple documentation.

Configuring the Conferencing App

You can change the configuration options for the Conferencing app at any time from the Settings tab on the Conferencing Home screen.

1. Enter the IP address or FQDN of the UCB server the app will communicate with.
   - Be aware that this field is populated automatically if the app is accessed from a conference link.

2. (Optional) Enter the phone number of the iPhone you are using.

3. Do one of the following:
   - To sign in using your ShoreTel credentials, enter your user name and password.
   - To sign in as a guest, move the Sign in as a guest slider to ON, and then enter your first and last name.

4. Tap Save to save these settings.

Hosting and Joining a Conference

Using the Conferencing app, you can start or join a conference. Conferences must be created using the ShoreTel Conferencing Web Portal; conferences cannot be created using the Conferencing app.

For information about creating conferences, see Creating Conferences on page 28.
Hosting a Conference

To start a conference, enter the host access code on the Conferencing Home screen, and then tap Join. You cannot start a conference if you are logged into the app as a guest; you must log into the app using your ShoreTel credentials.

Joining a Conference

Authenticated users and guests can join a conference using the Conferencing app.

1. Do one of the following:
   - Launch the Conferencing app, enter the conference access code on the Home screen, and then tap Join.
   - Tap a conference link in an email or calendar. The Conferencing app launches automatically.
   - In the Conference Web Portal, enter the conference access code, and then tap Join. The Conferencing app launches automatically.

2. If prompted, do one of the following:
   - Enter the conference password, and then tap OK.
   - Enter your name, and then tap OK.

You are joined to the conference.

Working with the Conference Screen

After you have started or joined a conference, the Conference screen appears. The name of the conference appears at the top of the screen.

The following table describes the buttons that appear at the bottom of the Conference screen.

<table>
<thead>
<tr>
<th>Table 21: Conference Screen</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions</td>
<td></td>
</tr>
<tr>
<td>Messages</td>
<td></td>
</tr>
<tr>
<td>Participants</td>
<td></td>
</tr>
<tr>
<td>Info</td>
<td></td>
</tr>
</tbody>
</table>
Viewing Conference Information

Tap the **Info** button to view conference information. The following information is displayed:

- Conference Name
- Host Name
- Conference Dial-In Number
- Host Code (displayed for Host only)
- Access Code

Viewing the List of Participants

Tap the **Participants** button to view the list of participants that have joined the conference. The Participants screen displays status information for each participant.

**Table 22: Participant Status**

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Participant has permission to present.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Participant is currently presenting.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Participant has audio call.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Participant is speaking.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Participant call is muted.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Participant has hand raised.</td>
</tr>
</tbody>
</table>

Editing Participant Options

The conference host can edit options for each participant joined to the conference.

On the Participants screen, tap the participant to edit options for. The following options are available:

- Allow present: Allow the participant to present.
- Remove participant: Remove the participant from the conference.
- Mute phone: Mute the participant. (Available only for participants with audio.)
- Disconnect phone: Disconnect the participant’s phone from the call. (Available only for participants with audio.)
Presenting

The host and any user with permission to present can share items using the Conferencing app. The following types of information can be shared:

- Pictures: Image files stored in the Library.
- Presentations: Presentation stored in the Library. The ShoreTel Conferencing app does not support sharing SWF presentations.

Presenters must be logged in using their ShoreTel credentials to share items from their Personal Library. Participants logged in as guests can only share items from the Public Library.

Items are added to the Library using the ShoreTel Conferencing Web Portal. For information about adding items to the Library, see the Adding Media to Personal or Shared Library on page 19.

To share an item, follow these steps:

1. Tap the **Actions** button.
2. Tap **Share From Library**.
3. Under **Shared** or **Personal**, select **Pictures** or **Presentations**.
4. Select the picture or presentation to share.
   
   A preview of the item displays.
5. Tap **Share**.

Viewing Presentations

When the host or presenter shares their desktop, the Conference whiteboard, a picture, or a presentation, the shared image is displayed automatically on the conference screen.

Although the Conferencing app does not support sharing the desktop or the Conference whiteboard, the app does support viewing this information.

The following types of information can be viewed from the Conferencing app:

- Desktop sharing
- Conference whiteboard
- Sent files
### Viewing Files

When a file is sent by the conference presenter, a message appears on your device. To view the file, tap **OK**.

The following file types can be viewed on your iPhone or iPad.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Type</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF</td>
<td>RTF</td>
<td>PNG</td>
</tr>
<tr>
<td>XLS</td>
<td>KEY</td>
<td>JPG</td>
</tr>
<tr>
<td>PPT</td>
<td>NUMBERS</td>
<td>BMP</td>
</tr>
<tr>
<td>DOC</td>
<td>PAGES</td>
<td>GIF</td>
</tr>
</tbody>
</table>

### Messaging

You can send a public message to all conference participants or a private message to a single participant at any time during a conference.

#### Sending a Message

1. Tap the **Messages** button on the Conference screen.
2. (Optional) To send a private message, tap the **Participants** button, and select the participant to send the message to.
3. Enter a message in the message field.
4. Tap **Send**.

#### Receiving a Message

When another participant sends a message to you, an alert is displayed on the Conference screen. To view the message, tap the **Messages** button.

---

**Note**
The ShoreTel Conferencing app does not support viewing Adobe Flash presentations (SWF files).
Conference Actions

The following table lists and describes the conference actions available from the Actions screen. To view the Actions screen, tap the Actions button on the Conference screen.

The actions available depend on your conference role.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Available for Host?</th>
<th>Available for Presenter?</th>
<th>Available for Participant?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute All</td>
<td>Mute all audio participants.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Raise/Lower Hand</td>
<td>Raise or lower hand.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Call Attendee</td>
<td>Enter the phone number, and tap Call to add an audio participant to the conference.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Call Me</td>
<td>Tap Call to call your own phone from the conference. If you did not configure your number in the Conferencing app, you will first need to enter your number, and then tap Call.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Mute</td>
<td>Mute your phone.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Share from Library</td>
<td>Choose an item from the library to share with the conference participants.</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Record Conference</td>
<td>Record the conference.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Stop Recording</td>
<td>Stop recording the conference.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Lock Conference</td>
<td>Lock the conference to prevent additional participants from joining.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Unlock Conference</td>
<td>Unlock the conference to allow additional participants to join.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Restart Conference</td>
<td>Restarts a conference.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>End Conference</td>
<td>End the conference and return to the Conferencing Home screen.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Leave Conference</td>
<td>Leave the conference and return to the Conferencing Home screen.</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
CDMA Devices

CDMA iPhones do not support simultaneous voice and data over cell. If you are on a call, the app will not work properly. This happens only if the device is connected over cell. If the device has a wifi connection, everything will work fine.
CHAPTER 9

Microsoft Outlook Integration

This chapter provides instructions for using the ShoreTel conference integration with Microsoft Outlook. It contains the following information:

- Overview ................................................................................................................... 82
- Microsoft Outlook Calendar....................................................................................... 82
  - Integrating with Microsoft Outlook Calendar....................................................... 82
  - Creating a Conference in Outlook ................................................................. 82
  - Changing conference settings in Outlook....................................................... 84
  - Conferencing Parameters............................................................................... 84
- Uninstalling ShoreTel Calendar Integration Tool in Outlook.......................... 86
Overview

This chapter describes how to install the ShoreTel module in the Microsoft Outlook calendar and how to use the module to create and access ShoreTel conferences.

Microsoft Outlook Calendar

Integrating with Microsoft Outlook Calendar

ShoreTel conferencing integrates with Microsoft Outlook 2007 Calendar and Microsoft Outlook 2010 Calendar to allow you to create and post ShoreTel conferences in the Microsoft Outlook calendar.


2. Launch ShoreTel Communicator.

3. On the toolbar, click Tools > Options (or, click the ShoreTel logo and select Options in the drop-down menu).

   The Options and Preferences window is opened.

4. In the menu, click Outlook.

   The Outlook page is opened.

5. In the Calendar section, click Install.

   Note
   If Outlook is open, the Shutdown Application pop-up is opened. You can close Outlook or leave Outlook open. Click Ignore. If Outlook is left open, you must close and re-open it for the install to take effect. When Outlook is re-opened, the ShoreTel Conference application is displayed on the toolbar of the Action tab in the Microsoft Calendar.

Creating a Conference in Outlook

You can schedule two types of conferences in Outlook:

- One-time appointments that occur on a single date and time.
- Recurring appointments that occur over a period of time.

   Note
   Conferences created in Outlook that have a duration of more than 8 hours are displayed in the ShoreTel conference Web Portal as having a duration of 8 hours.
Creating a Conference in Microsoft Outlook

1. Launch Microsoft Outlook.
2. In the navigation bar, click Calendar.
3. In the menu bar, select Action > New Appointment
   A blank Appointment window is opened.
4. Set the parameters for the meeting.
5. Click Conference (in ShoreTel application listing).
6. Click Create.
   A ShoreTel conference is created with a unique conference ID.
   The conference ID, dial-in number, and other conference information is included in the e-mail message sent to invitees and in the calendar posting created when the message is sent.
7. Click Send.
   Conferences created in Outlook are displayed in the ShoreTel conference Web portal. These conferences cannot be modified or deleted using the ShoreTel conference Web portal.
   Recurring conferences created in the ShoreTel conference Web portal are not displayed in the Outlook calendar.

Joining a scheduled conference from Outlook

1. Launch Microsoft Outlook.
2. In the navigation bar, click Calendar.
3. Double-click a listed meeting.
   The Meeting window is opened.
4. Click Join Conference (in the Outlook ribbon).
   An Internet browser is launched, and the Web page for the conference is opened.
   The Audio Conference dialog is also opened, showing the dial-in number and access code for the conference.
5. Click More Dial Info.
   The in-house extension for conferences is listed.
   The external phone number for the conference is also listed.
   These numbers connect you to the audio portion of the conference.
6. If you are the conference host or presenter, click Start to share your desktop.
Deleting a conference from Outlook

1. Launch Microsoft Outlook.
2. In the navigation bar, click Calendar.
3. Double-click a listed meeting listing.
   The Meeting window appears.
4. Click Conference (or click the ShoreTel icon then click Delete).
   The meeting is deleted from the conference schedule but remains in Outlook as a meeting.

Changing conference settings in Outlook

You can specify the following settings:

- conference ownership and access
- conference starting points
- conference record commentators
- password entry
- participant entrance and exit signals

Conferencing Parameters

When a change is made in Outlook to the properties of a recurring meeting, the only item the user can change is the subject of the meeting (not the date or time), because it is considered a reservationless conference. (Outlook prompts the user, "This is a recurring appointment, do you want to open only this occurrence or the series?") A change of subject made to a single occurrence (time, day of week, etc) is applied to the entire series in the ShoreTel Conference Web Portal, even though Outlook reflects only the change to the single occurrence.

When a recurring meeting is scheduled through Outlook, it appears in the ShoreTel Conference Web Portal under the Reservationless conference list. If a recurring meeting is later changed into a scheduled meeting, the system does not move the meeting under the Scheduled Conference list, even though the meeting type is different.

For the above two limitations, if a user does not want to change the entire series or have a meeting appear under the incorrect meeting list, the user must delete and then recreate the meetings with the correct details or meeting type.

Changes to the options do not take effect while the conference is in session. You must stop/start a conference for options to take effect. Outlook created cons cannot be edited by the Web Portal.

Setting Conference Parameters

1. Launch Microsoft Outlook.
2. In the navigation bar, click Calendar.

3. Double-click a listed meeting.

   The Meeting window is opened.

4. Locate the ShoreTel Conference icon and do the following:

   a. Click the bottom half of the ShoreTel Conference icon. A dropdown menu appears.

   b. Click Settings.

5. Change the following as desired:

   - In the Host Code field, enter the ShoreTel conference host code that you want to use for this conference.
   - In the Participant code field, enter a valid participant code associated the host code.
   - In the My extension field, enter the ShoreTel extension of the host associated with the host code.

6. Click the Advanced Options button to display to Advanced Options section of the window.

7. Select the parameters that you want to apply to the conference. The options are defined in Table 24.

8. Click OK.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conferencing</strong></td>
<td></td>
</tr>
<tr>
<td>Start the conference only when I join</td>
<td>Conference starts after you, the host, join. Participants who dial in early are put on hold until you join the conference.</td>
</tr>
<tr>
<td>Start the conference only when I join and list my conference in the Public page</td>
<td>Conference starts after you, the host, join. The conference is listed under your name in the conference Web page on the Public tab.</td>
</tr>
</tbody>
</table>
| Start the conference only when anyone joins | Conference starts after someone dials in.  

   NOTE: For security, do not make conferences with these settings public. |
| Start the conference when anyone joins and make everyone a presenter | Conference starts after someone dials in, and allow any participant to present.  

   NOTE: For security, do not make conferences with these settings public. |
| **Comments**                         |                                                                                                                                                                |
| Allow public comments                | Allow anyone to make conference comments.                                                                                                                      |
| Private comments only                | Require participants to send comments to host for inclusion in conference comments.                                                                          |
Uninstalling ShoreTel Calendar Integration Tool in Outlook

The calendar integration tool in Microsoft Outlook does not schedule conferences when the user is switched from a ShoreTel Converged Conferencing bridge to a ShoreTel Service Appliance.

In order to re-enable the conference scheduling feature, the user must first uninstall Outlook Calendar integration and then re-install it.

This section describes how to uninstall the calendar integration feature.

Uninstalling Integration with Outlook Calendar for ShoreTel Converged Conferencing

1. Launch ShoreTel Communicator.
2. On the toolbar, click **Tools > Options** (or click the ShoreTel logo and select Options in the dropdown menu). The Options and Preferences window appears.
3. In the menu, click **Outlook**. The Outlook page appears
4. In the Calendar section, click **Uninstall**.

**Note**

If Outlook is open, the Shutdown Application pop-up appears. You can close Outlook or leave Outlook open. Click Ignore. If you leave Outlook open, you must close and re-open it for the uninstall to take effect.

When you re-open Outlook, the ShoreTel Conference application no longer appears on the toolbar of the Action tab in Microsoft Calendar.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable comments</td>
<td>Disallow conference comments.</td>
</tr>
<tr>
<td><strong>Access</strong></td>
<td></td>
</tr>
<tr>
<td>Use a conference password</td>
<td>Check to require participants to use a password to enter the conference. In the field, enter the password that you want participants to use.</td>
</tr>
<tr>
<td><strong>Entry and exit tone</strong></td>
<td></td>
</tr>
<tr>
<td>None</td>
<td>Select to specify that no tone is used to indicate participant entry or exit during the conference.</td>
</tr>
<tr>
<td>Tone</td>
<td>Select to specify that a tone is used to indicate that a participant has entered or exited the conference.</td>
</tr>
<tr>
<td>Detailed</td>
<td>Select to have the system prompt participants for their name when the enter or exit the conference.</td>
</tr>
</tbody>
</table>
Table 1: Telephone Command Key Sequence

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#0</td>
<td>List available commands</td>
</tr>
<tr>
<td>#1</td>
<td>Mute/unmute your own line during conference</td>
</tr>
<tr>
<td>#2</td>
<td>Host only - mutes/unmutes all lines</td>
</tr>
<tr>
<td>#3</td>
<td>Host only - lists conference participants</td>
</tr>
<tr>
<td>#4</td>
<td>Host only - start/stops recording</td>
</tr>
<tr>
<td>#5</td>
<td>Host only - lock/unlocks conference</td>
</tr>
<tr>
<td>#99</td>
<td>Host only - ends the audio and web conference</td>
</tr>
</tbody>
</table>